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. College*: | College Pharmacy, Pharm Sciences v

Department™®: | Pharmacy Practice v

. Contact Person*: Mariann Churchwell Phone: 383-1567 (xxx-xxxx) Email:

mariann.churchwell@utoledo.edu

. Alpha/Numeric Code (Subject area - number)*: PHM - 6100

. Proposed title*: Oncology

Proposed effective term*: 202110 (e.g. 201140 for 2011 Fall)

- Is the course cross-listed with another academic unit? Yes No

Approval of other academic unit (signature and title)
Is the course offered at more than one level? Yes No
If yes, an undergraduate course proposal form must also be submitted. If the undergraduate course is

new, complete the New Undergraduate Course Proposal; if the undergraduate course is existing, submit
an Undergraduate Course Modification Proposal.

. Credit hours*: Fixed: 2 or Variable:

to

7. Delivery Mode: Primary* Secondary Tertiary
a. Activity Type * Lecture v --SelectType-- v —-SelectType-- v

b. Minimum Credit 2
Hours *
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Hours *

c. Weekly Contact 2
Hours *

Terms offered: Fall Spring Summer

Years offered: Every Alternate
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Year Years

9. Are students permitted to register for more than one section during a term?

No
May the courses be repeated for No * Yes Maximum Hours
credit?
10. -
) Normal Grading (A-F, S/U,
Grading WP/WF, PR, 1)
System™:
Satisfactory/Unsatisfactory (A-C,
less than C)
Grade Only (A-F, WP/WF, PR, )
Audit Only
No Grade

Yes

11. Prerequisites (must be taken before): i.e. C or higher in (BIOE 4500 or BIOE 5500) and C or higher in
MATH 4200

none

P
PIN (Permisson From Instructor)

PDP (Permission From Department)
Co-requisites (must be taken together):

PHPR 6460

4
12.

Catalog Description* (75 words Maximum)

An integrated course that includes Pharmacology, Medicinal and Physiological

Chemistry, and Pharmacy Practice, to study of etiology, pathophysiology,
clinical presentation, diagnosis, and treatment of cancer.

13. Attach a syllabus - a syllabus template is available from the University Teaching Center. Click
here for the Center’s template.

File Type View File
Syllabus View

14. Comments/Notes:
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by the Accreditation Council for Pharmacy Education.
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Oncology

The University of Toledo
College of Pharmacy and Pharmaceutical Sciences
Pharmacy Practice Department

PHM 6100
Coordinator: Marcia Honisko, PharmD, RPh Class Location:
Email: marcia.honisko@promedica.org Class Day/Time:
Office Hours:  No office on UT campus Lab Location:  N/A
Office Location: Email for appointment Lab Day/Time: N/A
Term: Spring Credit Hours: 2

Other Instructors:

Paul Erhardt, PhD

Faculty Office: HEB 292D/ WO 2206B
Phone: 419-383-2167/ 419-530-2167
E-Mail: paul.erhardt@utoledo.edu
Office Hours: TBA

Amit K. Tiwari, BPharm, MS, PhD

Faculty Office: HEB 282F

Phone: 419-383-1913

E-Mail: amit.tiwari@utoledo.edu
Office Hours : TBA

CATALOG/COURSE DESCRIPTION
An integrated course that includes Pharmacology, Medicinal and Physiological Chemistry, and Pharmacy Practice,
to study of etiology, pathophysiology, clinical presentation, diagnosis, and treatment of cancer

COURSE STATEMENT

Introductory lectures will cover basic principles of oncology from a pharmacological and clinical perspective, and of
selective toxicity from a medicinal and physiological chemistry perspective. Specific hematological and solid tumor
types of cancer will then be studied in more depth while emphasizing the most commonly utilized drugs.
Information pertinent to diagnosis and stage definition, drug selection and administration protocols,
pharmacodynamic mechanism, pharmacokinetic profile, adverse effects and drug-drug interactions, will be
discussed relative to both treatment and supportive care. Chemical functional groups will be used to define
distinguishing structural features and key structure-activity relationships for selected drugs as appropriate for each
of these areas.

COURSE GOALS

1. Introduce students to: basic concepts needed to understand the pathophysiology and pharmacotherapy of
the most common oncology disease states; the fundamental medicinal and physiological chemistry
principles needed to appreciate how the related drugs achieve varying degrees of selective toxicity; and
the knowledge and skills needed for application of the Pharmacist Patient Care Process within oncology.

2. Enhance students’ understanding of the pathophysiology and pharmacotherapy in oncology including
dosing considerations for renal and hepatic impairment, drug interactions and adverse effects, and
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monitoring recommendations specific for different types of cancer with a focus upon leukemia, lymphoma,
multiple myeloma, lung, colon, breast and prostate cancers.

3. Enhance students’ understanding about the medicinal and physiological chemistry relationships between
selected drugs and their use during pharmacotherapy of these same cancer types by highlighting the key
roles played by chemical functional groups as distinctly displayed within a given structure.

UNIVERSITY OF TOLEDO COLLEGE OF PHARMACY AND PHARMACUETICAL SCIENCES PHARM.D. ABILITY BASED
OUTCOMES (ABO's) FOR THIS COURSE

Domain 1 - Foundational Knowledge

1.1. Learner (Learner) - Develop, integrate, and apply knowledge from the foundational sciences (i.e.,
pharmaceutical, social/behavioral/administrative, basic biomedical sciences and clinical sciences) to evaluate the
scientific literature, explain drug action, solve therapeutic problems, and advance population health and patient
centered care.

Domain 2 - Essentials for Practice and Care

2.1. Patient-centered care (Caregiver) - Provide patient-centered care as the medication expert (collect
and interpret evidence, prioritize, formulate assessments and recommendations, implement, monitor
and adjust plans, and document activities).

Domain 3 - Approach to Practice and Care
3.1. Problem Solving (Problem Solver) — Identify problems; explore and prioritize potential strategies;
and design, implement, and evaluate a viable solution.

STUDENT LEARNING OUTCOMES

1. Explain the causes, pathophysiology, clinical presentation, stages and diagnosis of leukemia, lymphoma,
multiple myeloma, lung, colon, breast and prostate cancers. Aspects of diagnosis include: patient history;
physical exam; and clinical tests, procedures and data interpretation. (ABO 1.1)

2. Be able to design, implement, monitor, evaluate and adjust a patient-specific, evidence-based
pharmacotherapy plan for these same types of cancers including supportive care. (ABOs 2.1, 3.1)

3. Identify and prevent medication misuse and abuse. (ABO 1.1, 2.1, 3.1)

4. Be able to identify and explain key pharmacophores responsible for efficacious activity and degree of
selective action, as their distinctive displays of chemical functional groups within selected drugs used for
these same types of cancers. (ABOs 1.1, 3.1)

5. Be able to identify and explain the key molecular features responsible for pharmacokinetic profile,
metabolic disposition, and adverse effects at the biochemical level for selected drugs used for these same
types of cancers. (ABOs 1.1, 3.1)

6. Recognize, prevent, correct and treat adverse drug reactions, drug interactions, and other drug-related
issues pertaining to the drugs used to treat these same types of cancers. (ABO 1.1, 2.1, 3.1)

PHILOSOPHY OF TEACHING

The course outcomes will be achieved through in-class lectures, in-class cases, homework assignments, clicker questions,
quizzes, and PRE-RECORDED lectures available on Blackboard via Echo360.

There are 3 in-class examinations (2 in-module examinations and one comprehensive final examination). Examinations will
be on ExamSoft, paper exams, or a combination of both.

PREREQUISITES: None
COREQUISITES: PHPR 6460



THE UNIVERSITY OF

TOLEDO

REQUIRED INSTRUCTIONAL MATERIALS (TEXTS AND ANCILLARY MATERIALS)
Drug Information Handbook, 25t edition
Pharmacotherapy: Principles and Practice, 3" edition
Pharmacotherapy: A Pathophysiologic Approach 9t edition, online through Access Pharmacy

TECHNOLOGY EXPECTATIONS

Laptop computer or tablet device that allows a student to take online exams that utilize ExamSoft.
ExamSoft Exam policies can be found of the ExamSoft link in Blackboard.

Students will need to have access to Blackboard (http://www.utoledo.edu/dl/) online to obtain course
notes, readings, and information relative to the course. Course communication from instructors will be
through Blackboard.

A Turning Technologies ResponseCard (“clicker”) will be needed on certain days of the course.
More information on obtaining your “clicker” account can be found on the Blackboard link to Turning Point
Clickers.

UNIVERSITY POLICIES
Policy Statement on Non-Discrimination on the basis of Disability (ADA)

The University is an equal opportunity educational institution. Please read The University’s Policy Statement on
Nondiscrimination on the Basis of Disability Americans with Disability Act Compliance.

Academic Accommodations

The University of Toledo is committed to providing equal access to education for all students. If you have a
documented disability or you believe you have a disability and would like information regarding academic
accommodations/adjustments in this course please contact the Student Disability Services Office.

ACADEMIC POLICIES
Attendance, Absences, and Tardiness

The University of Toledo Missed Class Policy

This policy provides for basic protections and reasonable accommodations for students who miss class with excused
absences. Students are expected to attend every class meeting of courses in which they are registered. Only in
specific, unavoidable situations does the University excuse absences from class: 1) personal emergencies, including,
but not limited to, illness of the student or of a dependent of the student [as defined by the Board of Trustees’
Policy on Family and Medical Leave], or death in the family; 2) religious observances that prevent the student from
attending class; 3) participation in University-sponsored activities, approved by the appropriate University authority,
such as intercollegiate athletic competitions, activities approved by academic units, including artistic performances,
R.O.T.C. functions, academic field trips, and special events connected with coursework; 4) government-required
activities, such as military assignments, jury duty, or court appearances; and 5) any other absence that the professor
approves.

Students are responsible for complying with the missed class policies of their instructors. Students bear the
responsibility of notifying the instructor of a planned absence by one of the methods provided by the instructor. In
the event of an emergency or an unavoidably short notice of absence, the student must present the instructor with
an approved written excuse upon the student’s return to class. Approved written excuses will be at the instructor’s
discretion, including, but not limited to, doctor’s notice, funeral programs, etc. It is strongly recommended that the
student use two of the three aforementioned methods (email, writing, or voicemail) to insure that the instructor is
properly notified of the planned absence. In the event that the instructor should not receive the student’s
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notification, the student should be prepared to present an alternative excuse. It will be at the instructor’s discretion
to approve or disapprove of the alternative excuse.

Students are responsible for all material covered in classes they miss, even when their absences are excused as
defined above. Students must make arrangements with instructors to complete missed assignments, labs,
examinations or other course requirements. In turn, instructors are not to penalize students with excused absences.

Policies on Late Work
It is up to the instructor as to the acceptance of assignments not completed by the deadline and each case will be
evaluated individually.

Drop/Withdrawal

The petition for withdrawal must be received in the Office of the Registrar, Rocket Hall, Room 1100, by the deadline
date either: in person, fax, or mail. When mailing, the envelope must be postmarked by the deadline date. For the
fall and spring terms, it must be filed between the 15th calendar day of the term through Friday of calendar week
10.

Warning:

Withdrawing from a course(s) will result in a grade of "W", which will appear on your official transcripts. Once a
withdrawal is processed, it cannot be rescinded. Based on the date of withdrawal, fees may or may not be
adjusted. Since withdrawn courses reduce your enrolled hours, withdrawing from courses may have an adverse
effect on financial aid benefits, scholarships, loan deferments, athletic eligibility, health insurance, veterans
benefits, degree requirements, or other areas. If you are uncertain what effect withdrawing from the course(s)
would have, it is recommended that you contact the appropriate department for guidance.

Academic Dishonesty

Academic dishonesty will not be tolerated. Among the aims of education are the acquisition of knowledge and
development of the skills necessary for success in any profession. Activities inconsistent with these aims will not be
permitted. Students are responsible for knowing what constitutes academic dishonesty. If students are uncertain
about what constitutes plagiarism or cheating they should seek the instructor’s advice. Examples of academic
dishonesty include, but are not limited to:

e Plagiarizing or representing the words, ideas or information of another person as one’s own and not
offering proper documentation;

e  Giving or receiving, prior to an examination, any unauthorized information concerning the content of that
examination;

e Referring to or displaying any unauthorized materials inside or outside of the examination room during the
course of an examination;

e Communicating during an examination in any manner with any unauthorized person concerning the
examination or any part of it;

e Giving or receiving substantive aid during the course of an examination;

e Commencing an examination before the stipulated time or continuing to work on an examination after the
announced conclusion of the examination period;

e Taking, converting, concealing, defacing, damaging or destroying any property related to the preparation
or completion of assighments, research, or examination;

e  Submitting the same written work to fulfill the requirements for more than one course.

While academic integrity is particularly the responsibility of the student, the faculty members also have a
responsibility. Assignments and tests should be constructed and proctored so as to discourage academic dishonesty.
Faculty members are expected to inform their students explicitly as to what materials and procedures are
authorized for use in the preparation of assignments or in examinations (e.g., the use of calculator, computer, text
materials, etc.). Should cases of academic dishonesty be found among students, the instructor may choose to
counsel the student, or the following sanctions may be imposed:

4
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The student may be assigned an F for the work in question.

The student may be assigned an F for the course. In this case the instructor should inform the Dean and the
student of this action. The Dean will make certain that the student receives the F grade and is not
permitted to withdraw from the course.

The student may be placed on probation or suspended for some definite period of time, dismissed or
expelled by the Dean if either the seriousness of the offense or a record of repeated offenses warrants it. A
notation that such a sanction has been imposed will be made part of the student’s permanent record. It is
expected that the Dean will consult with the instructor and the student in making such a judgment, and
that the Dean will notify the student of the sanction imposed and of the appeals procedure.

A student found to be academically dishonest by a faculty member may appeal according to procedures approved
by the respective colleges. The procedures for making a final appeal to the Student Grievance Committee may be
found in the Student Handbook.

COURSE EXPECTATIONS

1.
2.

10.
11.
12.

13.

Classes are scheduled to start promptly.

All required readings are either out of required textbooks or from articles or textbooks that will be made
available at University libraries, student resource room files, or on-line. If a student chooses the
"photocopying route" of acquiring required readings, the photocopying will be the responsibility of the
student.

Telephones, pagers, or any other device that makes sound are to be turned off during lecture (or at least
be programmed into the “vibrating” mode) AND are NOT to be on or be set to a “vibrating” mode or be
used in any capacity during an examination.

No pets or children are to be brought to the classroom.

Students may audiotape lectures; otherwise, no A/V equipment, “smart” phones, “smart” watches, or use
of other telephotoing or televideoing devices are to be used during class.

For issues pertaining to lecture content, contact the lecturer of the topic. For issues pertaining to grades,
tests, lecture schedule, reading assignments, missing a class or test, etc., contact Dr. Borovicka. Issues
pertaining to grading should be brought to the instructor’s attention by the end of the second “workday”
following the day exam grades were made available.

Other than the Examination dates listed above, class attendance on lecture days, although expected, is not
a requirement for the course. If a student is absent from a lecture day, it is his/her responsibility to obtain
the material discussed in class on that day as well as obtaining any handouts, information, or
announcements presented to the class that day. On examination days, the course abides by The University
of Toledo Missed Class Policy.

When arriving tardy or leaving early from class, the student should do so in a manner that is not disruptive
to the class. If disruptive, the student is placing him/herself at risk of being removed from class on that day
and/or barred from class for one or more days in the future.

Students are expected to conduct themselves in a mature, professional manner and obey the principles of
the Professional Pledge between students and faculty.

During class, only one individual should be talking at any given time.
During class, students should behave in a manner that will NOT distract others.

Students should refrain from “surfing” the internet because studies have proven that a “surfing” student
not only distracts from his/her own learning but that of innocently distracted classmates.

The University of Toledo is a smoke-free and tobacco-free campus (includes ALL campuses, Policy 3364-
60-01). The use of all tobacco-derived products is prohibited on campus grounds and in classrooms.
Violators will be asked to leave the classroom. All tobacco-derived obtaining products include, but are not
limited to, cigarettes (clove, bidis, kreteks), electronic cigarettes or nicotine vaporizers, cigars, cigarillos,
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hookah smoked products, pipes, oral tobacco (e.g., spit and spitless, smokeless, chew, snuff) and nasal
tobacco. It also includes any product intended to mimic tobacco products, contain tobacco flavoring or
deliver nicotine other than for the purpose of cessation.

Examination Regulations

A.

Promptness - Students should be in the assigned examination room at the start of the class period. No extra time will
be permitted for students who arrive late for an examination. Students who do arrive late, provided no previously
arriving student has finished his/her examination and left the room, will be subject to losing 1 point for each minute
he/she is late. However, if a student arrives late, but after a previously arriving student has finished his/her
examination and left the room, the tardy student will be considered to have been absent from the examination and
will be treated as described below in MAKEUP EXAMINATIONS.

Articles in Examination Room — Purses, backpacks/bookbags, pencil pouches, notebooks, papers, books, telephones,
electronic devices, or anything not needed for you to take a test should be away from the examination seating desk
and area. Coats, hats, or any other clothing should be placed away from your examination desk. Food and drinks are
not permitted on your examination desk. Faculty for this course will provide tissues for those with “sniffles.” The use
of pagers, telephones, PDAs, or other electronic equipment is not permitted to be used in any capacity during an
examination and are not to be used in the classroom and should be turned off. Unless otherwise noted, only #2
pencils will be permitted at your desk. Students should bring several #2 pencils since portions of exams may be
computer graded. Calculators can be used on examinations only when permitted. When calculators are permitted,
instructors should be notified of calculators that are programmable and/or have alphanumeric functions.

Calculators can be used on examinations only when permitted. When permitted, the only calculator permitted is the
TI-30X 1IS (without its cover). No other calculator will be permitted even if you were allowed to use the calculatorin a
different course. Each student is to have his/her own calculator. Students are NOT to use “smart” eyeglasses,
watches, or any other such device during examinations.

Violation of the Student Academic Code - Violation of the student academic code WILL NOT BE TOLERATED on any
examination. Individuals accused of a violation will be prosecuted according to the policies and procedures of the
College and University and subject themselves to receiving a grade of “0” on the examination or a grade of “F” for the
course.

Seating - Instructors in the Course reserve the right to seat individuals during examinations as necessary.

Format of Examinations - The format of each examination is determined by the instructor(s) responsible for that
section of lectures. Multiple choice, essay, true/false, fill-in, matching, or any combination of these may be utilized.

Asking Questions - Technical questions (misspellings, missing a page, wrong numbering or lettering, etc.) will happily
be answered during examinations. Any questions regarding interpretation of an exam question are encouraged to be
written out on the facesheet and be brought to the attention of the instructor when handing in the test. When doing
so, “check” the box on the front of the facesheet and indicate the question you have an inquiry on. Additionally, if you
have questions regarding any ExamSoft exam question, you may note them in the comments section of ExamSoft.

The use of dictionaries of any sort during examinations is prohibited.

Consumption of food or beverages, the use or expectoration of chewing tobacco, smoking, or
listening/viewing to audio/video equipment, is not permitted during examinations. No drinking or items to be
ingested are to be at your seat.
Conversing with anyone other than instructors is not permitted once answer sheets and/or tests are
being passed out. One may resume conversation once they have left the testing room. When speaking outside the
classroom following an exam, voices should be at a level that will not disrupt those remaining who are still taking the
exam.
Items in one’s possession (watches, pencils, etc.) during an examination are subject to inspection.
Students are responsible for assuring answer sheets to examinations are marked properly and that they have not
overlooked answering any questions on the test before handing in the examination.
Students shall treat their answer sheets and test booklets in a manner that does not allow or tempt other students to
look at them.
Students who request the use of the lavatory during an exam are subject to a 5-point deduction of their examination
score.
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0. If aclass period, during which an exam or quiz was to be given, is canceled or interrupted, assume the exam or quiz
will be given during the next scheduled class period if it is not completed on the assigned day.

P. Grades can only be passed out directly to the student or mailed (via U.S. mail) directly to the student. Grades cannot
be given over the phone, to a friend, or via email.

Q. ExamSoft may be used for exams.

Makeup Examinations And Quizzes
A. Unexcused absences resulting in a missed exam or quiz will result in a grade of zero.

B. Makeup exams will only be administered for excused absences. Prior approval for an absence from an examination
can only be obtained from acknowledged direct contact with the course coordinator. Post-exam approval for an
excused absence from an examination must be sought out immediately upon the student's arrival back to school.
Documentation of why the absence occurred will be required.

C. Makeup examinations will be given during Finals Week. The examination format will be at the discretion of the
course instructors.
D. Makeup quizzes will NOT be offered for students who miss quizzes.

E. Exceptions may be rarely possible with emergencies upon the discretion of the Course Coordinator.

Calculators:

The required calculator for this course is a TI-30X lIS. You are expected to use this calculator for all exams/quizzes
and in class exercises. The instructors will be monitoring this and if you are using a different calculator, it will be
taken away and returned at the end of the exam or class. Sharing of calculators is NOT permitted so be sure to
always bring the TI-30X 1IS with you when you will be doing calculations. For exams, please remove the cover prior
to the time of the exam and leave it with your other belongings. The cover should not be at your seat. We have the
right to inspect calculators at any time if we suspect academic dishonesty of any kind.

OVERVIEW OF COURSE GRADE ASSIGNMENT

Exams — There are 2 scheduled exams, plus the final exam.

Exam 1 25%
Exam 2 25%
Final Exam 50%

Please note: Students earning less than a C on exams 1 or 2, will be referred to the Academic Enrichment Center
located in Mulford Library (room 506/507) for additional support and academic coaching.

Self-assessments and in-class work: There will be self-assessments made available for you to complete on your own
time. There will also be some in-class pain management cases. These will not be graded.

Grading Policy/Grading Scale
A course average of 90% assures an A
A course average of 80% assures a B
A course average of 70% assures a C
A course average of 60% assures a D

Midterm Grades can be calculated by averaging the scores of the first two examinations. Midterm
averages less than 70% denote that a course failure is a definite possibility. You should be meeting with
course faculty and tutors and the staff of the Academic Enrichment Center if the midterm grade is less
than a 70% average.

Attendance is also recorded during Midterm grading to meet state and federal laws regarding financial
aid disbursement. Please note, if you are not attending class it could impact your financial aid
(scholarships, grants, loans or Federal Work Study).
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If you decide you are not going to attend this class (or any other class you have registered for), you must
formally withdraw (drop) from the course. You can do this by logging onto the myUT portal, clicking on
the “Student” tab, and then under My Toolkit clicking on Register/Drop/Withdraw.

For more information about add/drop dates please visit the Registrar's Office online at:
http://www.utoledo.edu/offices/registrar/registration dates.html

Rechallenge Policy

To successfully complete this course according to post-baccalaureate portion of the PharmD curriculum, a grade of
C (2.00) or higher needs to be earned.

1. Astudent who earns a final course grade of D may elect to take a rechallenge exam. This rechallenge exam
will not be offered to students who earn any other grade, including a grade of F.

2. The rechallenge exam will be comprehensive. It will be offered one-time only at the convenience of the
instructors of this course. The rechallenge exam will be scheduled after the first of the year but before
[DATE]. Students who think they will be in a position where they would be interested in taking this exam
should assure that they would be able to be at the University of Toledo College of Pharmacy for whenever
the exam is scheduled during this time period. No make-ups of the rechallenge exam will be offered.

3. It will be the responsibility of students to find out what their grade is and to directly inform Dr. Honisko of
their interest in taking the rechallenge exam, when applicable, by [DATE]. Federal policy prohibits grades
from be given by instructors to students by email or over the telephone.

4. To successfully pass the rechallenge exam, a student must achieve an overall score of > 80% and must
achieve a score of > 70% on each of the instructors’ sections.

5. If a student passes the rechallenge exam and had originally received a grade of D, the grade will be
changed to a C. If a student fails to pass or to take the rechallenge exam, the original grade will not be
changed. Repeat rechallenge exams (i.e., re-rechallenge exams) will not be offered, even if the student
failed to pass the rechallenge due to being unable to achieve a 70% or better in an individual instructor’s
section.

6. Rechallenge exams will NOT be offered to students who fail to take Exams #1 or #2, at the originally
scheduled time. Such students will forfeit their opportunity to be considered for a rechallenge exam if
their subsequent final course grade is a D.

7. Rechallenge exams will not be offered to students caught violating the student academic code (i.e.,
cheating) in this course and/or violating the principles of the professional pledge in relation to this course.

8. These policies may be amended for unforeseen circumstances not originally accounted for by the
instructors.

ACADEMIC SUPPORT SERVICES

The University of Toledo is committed to your academic success and offers a wide array of programs and services to
ensure success, here are a few examples of resources available to you:

University Libraries
University Libraries are your gateway to information at The University of Toledo connecting you with the
resources you need for education, research, and patient care.

The Writing Center
The Writing Center provides free, face-to-face and online tutoring for writers in all disciplines. The staff
there can assist you with a variety of writing assignments.
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https://www.utoledo.edu/success/writingcenter/
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The Counseling Center

Maintaining a healthy well being while attending college can be difficult, if you or a friend ever feel
overwhelmed adjusting to college or in need of crisis intervention or mental health services please contact
the Counseling Center.

Academic Enrichment Center
Students earning less than a C on exams 1, 2, or 3 will be referred to the Academic Enrichment Center
located in Mulford Library (room 506/507) for additional support and academic coaching.


http://www.utoledo.edu/studentaffairs/counseling/
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COURSE SCHEDULE

Fall Schedule *Bring your Drug Information Handbook to class on this day

Lecture A Lecture B Exams
Weekl

Intro to Oncology Lymphoma
Week2

Myeloma Leukemia Examl
Week3

Lung Colon
Week4

Breast (Hormonel) Prostate (Hormone2) Exam?2
Week5

Supportive Palliative & Exam3 (comprehensive)

Miscellaneous

ExamSoft Procedures and Information

WHAT SHOULD BE DONE RIGHT NOW (IF NOT ALREADY DONE)
All students must download Softest.

This is the link to the University of Toledo homepage at ExamSoft: https://www.examsoft.com/dotnet/Default.aspx

Login in under Exam Takers using your utad ID and your password. You were sent an email with your login and
password.

Select the download and training tab.

Follow the instructions to download Softest.

BEFORE EXAM DAY

IT1S YOUR RESPONSIBILITY TO FAMILIARIZE YOURSELF WITH YOUR COMPUTER EQUIPMENT AND THE SOFTEST
SOFTWARE AND INSTRUCTIONS PROVIDED BY EXAMSOFT ON ITS WEBSITE PRIOR TO THE START OF YOUR EXAM.
PLEASE ALLOW YOURSELF SUFFICIENT TIME TO BECOME FAMILIAR WITH YOUR LAPTOP AND THE APPLICATION.

Confirm that there is plenty of free hard drive space on your computer.
Ensure that your PC is virus-free.

Locate the A/C battery power indicator light on your laptop and confirm you can determine you are running on A/C
power (i.e. power from a wall outlet).

Ensure that your battery has at least 20 minutes of charge in the event there is a temporary power outage during
the exam.

Ensure that your computer’s internal clock has the correct date and time. To verify the date and time, double-click
the clock in the lower-right corner of your screen.

YOU MUST DOWNLOAD THE EXAM BEFORE THE DAY OF THE EXAM.

You will not be able to access the exam until you are given a code unique for the exam.

ON EXAM DAY
e Bring your laptop, a fully-charged battery, and a computer power cord (if applicable). Failure to do this will
result in a 10-point deduction on your test score.

e Use the instructions that will be provided to you on exam day to launch SofTest.
Immediately before SofTest launches the exam, you will be provided a warning screen with RED STOP SIGNS
indicating that you should not begin the exam until instructed to do so. Heed this warning.
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e ANY ATTEMPT TO DISABLE OR TAMPER WITH SOFTEST’S SECURITY FEATURES WILL BE CONSIDERED A
VIOLATION OF THE APPLICANT HONOR CODE.

e Disable the sleep/hibernate mode on your computer during the exam. Some computers go into sleep/hibernate
mode during extended periods of nonuse. During an exam, it can be difficult to exit this mode. Refer to the
instructions for your operating system to modify these settings.

ON EXAM DAY (continued)

e PLEASE NOTE THAT COMMENCEMENT OF THE EXAM WILL NOT BE DELAYED DUE TO A HARDWARE OR
SOFTWARE PROBLEM WITH YOUR LAPTOP NOR WILL YOU BE PROVIDED ADDITIONAL TIME TO TAKE YOUR
EXAM.

So if you did not download the exam in advance you will lose time for taking the exam.

e ANY DELAY IN YOUR PERSONAL STARTING OF THE EXAM THAT RESULTS IN YOU STILL CONDUCTING THE EXAM
WHEN THE CLASS TIME TO END THE EXAM HAS ARRIVED MEANS YOU WILL HAVE TO STOP TAKING THE EXAM
REGARDLESS OF HOW MUCH TIME ExamSoft SAYS YOU PERSONALLY HAVE LEFT TO TAKE THE EXAM.

o If you encounter computer difficulty during the exam, notify a proctor for instructions; DO NOT UNINSTALL
SOFTTEST!!!

DURING THE EXAM TIPS FOR STUDENTS
Here are a few tips to improve your exam experience with SofTest. Visit ExamSoft Technical Support website for
more exam day resources.

Begin Exam Alert
You can set a timer to display a visible alert once your exam begins. Prior to launching an exam, access the
"Preferences" screen in the SofTest Start Window to set the alert. This window can be "snoozed."

Exam Progress Alarm
You can set a reminder alarm to appear at a specific time during the exam. Prior to launching the exam, access the
“Tools” > “Reminder Alarm" menu to set the alarm. This window can be "snoozed."

Resize Window
To enlarge or shrink the window in which you view the question or the answer, drag the horizontal bar that appears
between the question and answer areas of your screen up or down to suit your needs.

Hide Exam
To block your SofTest window during an exam (i.e. during a restroom break), select "View" then "Hide Exam."

Restore Setting
Use the "Restore Settings" option on the View menu if you have rearranged the window and cannot get it back to
the starting configuration.

Character Limit

Some essay questions may have a character limit. You can see the character count of any essay answer in the status
bar at the bottom of the SofTest window. If a limit is imposed, it will be displayed in the lower left corner next to the
question number.

Word Count

SofTest provides a word count for essay answers under “Tools” > “Word Count.” It includes the number of words in
the current answer, total number of words in all answers, character count for current answer and character count
for all answers. If text is selected in the current question, SofTest provides a word count and character count for the
selection.

Spell Check

11
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The ability to use the spell check feature is controlled by the test sponsor (institution or school that is administering
the exam).

Undo
SofTest can undo up to the last 50 actions in each essay response question.

Multiple Choice Questions

For multiple choice questions, the total number of response options appears in the status bar at the bottom of the
main window. If all of the options aren't visible because of your display and window configuration, use the scroll bar
that appears on the left side of the screen to view all of the options.

Notices
You can view the notices that appeared prior to beginning your exam by selecting “Help” > " Exam Notices."

Question Navigation
o Toggle (switch) between questions by using the blue navigation arrows or by using the keyboard combination
of 'Ctrl' and '> ' to move to the next question or 'Ctrl' and '< ' to move to a previous question

e Mark questions that you want to revisit. The Question Navigator button on the button bar displays a list of all
questions in a separate window.

e View unanswered questions and navigate to another question by clicking on the question number in the popup
window.
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